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Introduction

The TechSmith Deployment Tool is designed for Information Technology (IT) specialists or system
administrators responsible for installing Snagit throughout an organization. The tool enables the
administrator to customize and generate a Windows Installer Transform file (MST) and a BAT file.

To view or customize the individual registry settings for Snagit, see Snagit MSI Installation Guide.
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Download the Deployment Tool

1. Download the Snagit MSl file and the TechSmith Deployment Tool from
www.techsmith.com/enterprise-resources.html.

2. Double-clickthe TechSmith_Deployment_Tool.exe to launch the program.

Y,

-

TechSmith_De
yment_Tool

By default, the Deployment Tool generates the MST and BAT files into the same directory as where
the executableislaunched.
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Welcome Screen

s+ TechSmith Deployment Tool (snagitmsi): Welcome — X

}1 Welcome

Import Settings

<~ General Options
Disable Snagit Settings
Install Features
TechSmith Fuse

User Data Paths

B o @

-
=

Add Components

Snagit Registry File

Uninstall Cptions

TechSmith Relay Options

d By e P

Install Display Options

‘\I"'- Create Transform File

Welcome to the TechSmith Deployment Tool. This tool will generate a Windows Installer®
transform file (MST) so you can customize Snagit, Camtasia or TechSmith Relay Recorder to suit
your deployment needs.

This tool works with:

B Snagit (version 11 or later)
E Camtasia (version 8 or later)

m TechSmith Relay Recorder (version 4.3 or laten)

Download the latest Windows Installer® (MSI) from this webpage.

Alternatively, you can extract the MSI from your existing EXE download:

For Snagit 12, Camtasia 9 and later, install the WX toolset. Then, run on the command-line:
e dark %path%Snagit.exe -x %outputpath.

For TechSmith Relay Recorder, extract the M5[ by using a Zip utility.
For Snagit 11 and Camtasia Studio 8, run the EXE on the command-line with the switch /X

Mote that the executables are typically used for .NET Framework detection and installation.

Open MSI Package...

TechSmith Deployment Tool v3.3.0.126
Copyright © 2013-2019 TechSmith Corporation. All rights reserved.

1. Onthe Welcome screen, click the Open MSI Package button.

2. Select the Snagit.msifile. If you have not previously downloaded the MSI file, download the file here.

3. Click Open.

The MSI file opens in the Deployment Tool and displays the available options for creating a custom MST file.
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Customize a Snagit Deployment

Click through the tabs on the left side of the TechSmith Deployment tool to view the custom options

available.
“& TechSmith Deployment Tool (snagit.msi): General Options — x
N Welcome General Options
£ Begin by registering your software purchase and determining the installation path.
' - Import Settings Registration information
Username:
'® General Opticns Software Key:

Disable Snagit Settings Installation path

®) Use default installation path

=
:‘::l Install Features () Customize installation path:
fe

TechSmith Fuse

Installation options

! User Data Paths [] Create shortcuts on Desktop

Run Snagit when Windows starts

w Add Components
Advanced options
) _ ) Snagit performs optimizations when it detects it is running in a virtualized environment.
ﬂ. Snagit Registry File Snagit can auto-detect most environments or you can select whether Snagit is running on
a virtual machine,
?*h Uninstall Options Virtual Machine Optimization: | Auto-detect ~
m TechSmith Relay Cptions Product language
EMNU ¥

g Install Display Options )

TechSmith support

Allow users to upload Snagit crash logs securely to a TechSmith support agent
'\tl" Create Transform File

The following sections describe the options available on each screen:

« General Options
« Disable Snagit Settings
« Install Features Options

o TechSmith Fuse Options
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« User Data Path Options

o Add Components

« Snagit Registry File Options
« Uninstall Options

o TechSmith Relay Options
« Install Display Options

o Create Transform File
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Import Settings Options

“L TechSmith Deployment Toeol (snagit.msi): Import Settings - ot

Welcame Import Settings
N\

Import a Transform File (.mst) to use the previously selected settings.

Mote: Impaorting the transform file will reset your current Deployment Tool settings.
ﬂ»‘ﬁ-' Import Settings

Open M5T File...

adhe .
< '» General Options
g

B Disable Snagit Settings
e
i| Install Features
2
L

TechSmith Fuse
Uzer Data Paths

Add Components

-
& Snagit Registry File

Uninstall Cptions

TechSmith Relay Options

d k&

Install Display Options

\Tf Create Transform File

You can duplicate the settings used in a previously created MST file.
1. Onthelmport Settingstab, click the Open MST File button.

2. Browse to select the transform file (.mst).

Importing a transform file will reset your current Deployment Tool settings.

3. Click the Open button.

The Deployment Tool automatically selects the settings from the imported transform file.
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General Options

“i TechSmith Deployment Tool (snagit.msi): General Options — x
N Welcome General Options
A Begin by registering your software purchase and determining the installation path.
l Import Settings Registration information
Username:
« ~ General Options Software Key:

Disable Snagit Settings Installation path

®) Use default installation path

Install Features ) Customize installation path:

TechSmith Fuse

Installation options

3
E User Data Paths [] Create shortcuts on Desktop
2
=

Run Snagit when Windows starts

Add Components
Advanced options

Snagit performs optimizations when it detects it is running in a virtualized environment.
Snagit can auto-detect most environments or you can select whether Snagit is running on
a virtual machine,

Snagit Registry File

Uninstall Options Virtual Machine Optimization: | Auto-detect ~

TechSmith Relay Cptions Product language
EMNU -

g By e

Install Display Options
Al TechSmith support

Allow users to upload Snagit crash logs securely to a TechSmith support agent
AJ#. Create Transform File

Registration Information

Enter a username (e.g. your company or organization name) and the software key. If you have trouble
locating your software key, see License and Software Key FAQ.

If you enter a software key, make sure to select the Disable online Snagit registration dialog option on the
Disable Snagit Settings screen in the TechSmith Deployment Tool.
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Installation Path
By default, Snagitis installed to the following location on a user's machine:
%ProgramFiles%\TechSmith\Snagit 2020

To select a custom location, click the Browse button or enter a path to the desired directory.

Installation Options
« Create shortcuts on Desktop: Creates shortcuts for Snagit and Snagit Editor on the desktop.

« Run Snagitwhen Windows starts: Starts Snagit and the Capture Window. Snagit Editor startsin the
background.

Advanced Options
Snagit performs optimizations when it detects it is running in a virtualized environment. The performance
optimizationsinclude:

« Simplified appearance of the crosshairs when selecting an area to capture.

Optimizations On Optimizations Off

¢ Removed the shadow effect
« Do notextend the crosshair lines across the entire screen

« Removed the animation around the selected area
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o Afterselecting the area, the unselected area is not grayed out.

Optimizations On Optimizations Off

« When alarge desktop is detected:

» Snagit limits visual changes across the entire desktop.

« Snagit limits unnecessary animations.

Snagit can auto-detect most environments or you can select to always apply these optimizations. Select one
of the following options:

o Auto-Detect: Apply the optimizations when it detects that Snagit is running on a virtual machine.
o Yes: Always apply the optimizations.

o No: Do notapply the optimizations.

It is recommended to set this option to Yes when using virtualization technologies.

Product Language
Select the language for Snagit:
o ENU - English
o DEU - German
o FRA-French

TechSmith Support
Allow users to securely upload diagnostic files to our TechSmith support staff using the TechSmith Support

Toolin Snagit Editor.

The Support Tool is only available in Snagit version 2019.0.1 and later.
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Disable Snagit Settings

¢ TechSmith Deployment Tool (snagit.msi): Disable Snagit Settings — X

Welcome Disable Snagit Settings
N

Check any of the following features you would like disabled.

; Import Settings [ ] Disable automatic updates

[ ] Disable online Snagit registration dialog

-~ General Options )

e [ ] Disable Image Capture
Disable Vid

Disable Snagit Settings WL

[ ] Disable Printer Capture

g Install Features [ ] Disable online help
=

[ ] Disable TechSmith account sign-in
TechSmith Fuse .
[ ] Disable Share Manager

[ ] Disable local crash dump collection
' User Data Paths
[ ] Disable anonymous usage reporting More Information

== (O Don't show me notifications

Add Components ) )
) Only show me help notifications

(® Show me help and TechSmith promotions
Snagit Registry File

Y Uninstall Cptions

o

m TechSmith Relay Options
g Install Display Options

'\t"'- Create Transform File

When Should |
Consider Disabling It?

Description

e Asan
administrator, you

Automatic Automatically check for updates for Snagit. If disabled, the user will not o
. L . . want to maintain
Updates receive any application prompts when new versions are available.
control of
application
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When Should |
Consider Disabling It?

Description

updates across
the organization
and not allow
users to install
updates.

o Ifyouwantto
require individual
users or user
groupstobeona
specific version of
the application.

e You do notwant
the TechSmith
Uploader Service
toinstall during an
update.

o Prevents the
online registration
dialog from
displaying for
users.

Online
Snagit
Registration
Dialog

After installing, the Snagit Registration dialog appears which includes « Helps to prevent

options to register the software online and sign up for product user entered

announcements, customer stories, and free tutorials. errors when
registering the
software or
duplicating the
registration
information
online.

o Ifyou wantto
disable image
Image Image capture takes a snapshot of anything on your screen including a capture including
Capture region, window, scrolling window, or the entire screen. image capture
presets and
options.

o Ifusersare
Record, trim unwanted sections, and playback MPEG-4 or Animated GIF running Snagit on

videos in Snagit. a computer that
does not support

Video
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When Should |
Consider Disabling It?

Description

video system
requirements.

o« Toallow an
administrator to
control resources
(CPU/GPU/Band
width) when
deploying in
virtualized
environments.

o Ifrunning
Windows Server
2008 or Windows
Server 2008 R2 to
remove the video
capture and
playback options
for users. Video
playback and
decoding is not
supported on this
Os.

Snagitinstalls as a printer destination for programs with printing » When deploying

in a server
capability. environment (e.g.
@ Printers & scanners Remote Desktop
(L Aoeeror Services).
@ =
= R If you disable
printer
Printer o capture
Capture Microsafs XPS Document Weter make sure to
(L P PDF acDesicon also disable
e To OneNote 2016 the Snagit
(D, st 200 Printer option
on the Install
Features tab
o of the
The Printer Capture Option scans the documentin a program and Deployment
opens the capture in Snagit Editor. Tool
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When Should |
Consider Disabling It?

Description

o Ifthe websiteis
restricted in your
organization or if
users do not have
an internet
connection, you
can choose to
disable the online
help. Disabling
this option opens

The Snagit help file is located online and requires an internet connection. the basic help PDF
The online help provides content to assistin getting started in Snagitand whenever a user
accesses help in

to find answers to product questions. While offline, users can browse the ot
nagit.

Online Help basic help PDF located in Snagit.

The online help topics are located If you disable
here: https://support.techsmith.com/hc/en- online help,
us/sections/360003808671. we

recommend
providing
users access
to download
the full help
PDF located
here.

o Signinisnot
required for users
when a single or
multi-user key is
entered in the
Deployment Tool.

TechSmith TechSmith Accounts store user-specific information such as license « Signingintoa

Account keys, your user profile, and Screencast.com and TechSmith Relay logins. TechSmith

Sign-In See About TechSmith Accounts. accountallows
users to share to
Screencast.com
and TechSmith
Relay.

o You may consider
disabling this
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Description

When Should |
Consider Disabling It?

The Share Manager allows users to update, add, or remove share

i/\haar:: or destinations from Snagit. To access the Share Manager in Snagit Editor,
9 select Edit > Editor Preferences > Share tab.
Allow Snagit to write crash dumps to
Local Crash ) . .
Dum C:\Users\username\AppData\Local\TechSmith\Snagit\CrashDumps\
P . for diagnostic purposes. If this is disabled, crash dumps are written to a
Collection .
temporary file.
Send anonymous data on Snagit usage to help TechSmith improve
future versions. Learn more about TechSmith User Design Initiative
(TUDI).
Disable
anonymous To receive in-app notifications, such as help tips and TechSmith
usage promotions, you must enable anonymous usage reporting.
reporting
Snagit sends an initial message during installation for license
management and compliance purposes.
N TechSmith"

option if you do
not wantto
require users to
have TechSmith
accounts in your
organization.

If you select to
redirect the
destinations to a
path other than
the default.

If you do not want
to allow users to
update the
destinations.

When you need to
preserve drive
storage space.

When you must
follow internet
security
requirements that
restricts users
from sending data
to TechSmith.

Or, if you do not
want to
participate in the
feedback
program.
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Install Features Options

sl# TechSmith Deployment Tool (snagitmsi): Install Features — X

Welcome Install Features
N

Please select the features you would like to install.

Import Settings Snagit Printer &
Windows Explorer Menu Extension
; 4 []Share Destinations
~ - General Options Microsoft Word Destination
Microsoft Excel Destination
Microsoft PowerPoint Destination
B Disable Snagit Settings Screencast Destination
Camtasia Destination
(2- YouTube Destination
ﬁ I e Google Drive Destination
Dropbox Destination
) OneDrive for Business Destination
F TechSmith Fuse Microsoft OneMote Destination
TechSmith Relay Destination v
|7

' User Data Paths [ ] Force installation of Microsoft share destinations if Office is not installed on the target
system

% Add Components
& Snagit Registry File
% Uninstall Options
[
m TechSmith Relay Options
g Install Display Options

‘\I"- Create Transform File

Snagit share desinations are add-ons to help users upload content to third-party websites and applications.
The destinations appear in the Share dropdown in Snagit Editor.
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[C] copy Al [ERELEIC
Share 7  Share History {3
—J File g Email
@| FTP Program
e
Clipboard /=d Printer
@ Word b m PowerPoint b
Excel L Ei OneNote b
D Screancast.com - Camtasia b
m TechSmith Relay - “
‘ Google Drive b Q Dropbox b
‘ OneDrive For Busi.. [Sa'd EBox -
L]
q * Slack

Select which destinations are available to users. If you disable any of the options above, the destinations will
not appear on the Share tab for the end user.

Forexample, if YouTube is restricted in your organization, you may want to remove the destination in Snagit.

Option Description

Snagit Printer Snagitinstalls as a printer destination for programs with printing capability.
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Option ‘ Description

Printers & scanners

Ig:l Adobe PDF

Brother MFC-I820DW
Fax

Microsoft Print to PDF

Microsoft XPS Document Writer

Send To OneMote 2016

Snagit 2020

b W & @ op gb

The Snagit Printer option scans the current documentin a program and
opens the capture in Snagit Editor.

Allows users to quickly send and convertimages using Batch Export. To

Windows Explorer Menu Extension access Batch Exportin Snagit Editor, select File > Export.

) o The destinations appear in the Share dropdown in Snagit Editor and allow
Snagit Share Destinations

users to share their captures to popular applications.
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Option

Microsoft Word Share

Microsoft Excel Share

Microsoft PowerPoint Share

Screencast Share

Camtasia Share

YouTube Share

N TechSmith’

’ Description

© copy it [EIEEEN
Share 7  Share History L3
H File [=7 Email
@| FTP Program
=
Clipboard e=g Printer
@ Word b m PowerPoint b
Excel - Ei OneMota -
u Screencast.com - Camtasia -
m TechSmith Relay b “
‘ Google Drive b g Dropbox b
“ OneDrive For Busi... » Box -
-
q * Slack

Allows users to insert an image into a Microsoft Word document.
Allows users to insertan image into a Microsoft Excel workbook.

Allows users to insertan image into a Microsoft PowerPoint presentation
slide.

Allows users to upload an image or video onto Screencast.com for hosting.
Screencast.com provides a URL for quick sharing or an embed code for
adding the capture onto a website or blog.

Allows users to import an image or video into the TechSmith Camtasia media
bin.

You must have Camasia version 7.0 or later installed to share
captures using this output.

Allows users to upload a video onto YouTube for video hosting. YouTube
provides a URL for quick sharing to your audience or an embed code for
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Option ’ Description
embedding the capture on a website or blog.

Allows users to upload an image or video to Google Drive for image or video

Google Drive Share hosting. Snagit sends the share link to the Clipboard.

Allows users to upload an image or video to Dropbox for image or video

Dropbox Share hosting. Snagit sends the share link to the Clipboard.
OneNote Share Allows users to insertan image into a Microsoft OneNote notebook.
Allows users to upload an image or video to TechSmith Relay. Snagit sends
the share link to the Clipboard.
TechSmith Relay Share Deselect this option if you are disabling installation of the
TechSmith Uploader Service under the TechSmith Relay Options
tab.
Slack Share Allows users to upload an image or video to a Slack workspace. Snagit sends
the share link to the Clipboard.
Box Share Allows users to upload an image or video to Box for image or video hosting.

Snagit sends the share link to the Clipboard.
Force installation of Microsoft share Forces the installation of Microsoft Office share destinations when Snagit

destinations if Office is not installed does not detect Office installed on the PC. Recommended for customized or
on the target system cloud installations of Office.
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TechSmith Fuse Options

“& TechSmith Deployment Tool (snagit.msi): TechSmith Fuse — x

Mobile Sharing with TechSmith Fuse
Welcome
X\

Mabile Sharing allows Snagit to receive files from TechSmith Fuse. TechSmith Fuse is a mobile
app that allows you to send images and videos from your mobile device directly to Snagit. You

' * Import Settings can capture, collaborate, and access your content - wherever you are,

g _ Enable Techsmith Fuse
General Opticns

A

Port number: | 8299 Configure this number if it conflicts with port numbers
’ used in your organization.

g Disable Snagit Settings
=
:l::l Install Features
F TechSmith Fuse
E" User Data Paths
i
w Add Components
% Snagit Registry File
Uninstall Cpticns

TechSmith Relay Cptions

d By e

Install Display Opticns

'\t" Create Transform File

TechSmith Fuse is a mobile app that allows you to send images and videos from your mobile device directly to
Snagit. You can capture, collaborate, and access your content - wherever you are.

Fuseisavailable from the App Store or Google Play and supported on mobile devices running the following
operating systems:

o iOSversion 10.3 and later (phones and tablets)

« Android version 4.0.3 and later
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Some security settings and wireless network environments may not allow connectivity to a desktop.
Make sure to confirm port 8299 is open when working in a virtual environment.
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User Data Paths Options

“& TechSmith Deployment Tool (snagit.msi): User Data Paths — x

n Welcome

l ¢ Import Settings

~

General Opticns
g Disable Snagit Settings
=
ﬁ::l Install Features
F TechSmith Fuse
E User Data Paths
i
ﬁ Add Components
% Snagit Registry File

Uninstall Cpticns

TechSmith Relay Cptions

g By e

Install Display Opticns

'\‘If Create Transform File

Customize User Data Paths

In this page you can customize the location of the user data.
Automatically stored files

Snagit automatically saves all captures into the selected folder below.
Mote: The location cannot be shared by multiple users or accessed by a single user from
two locations at the same time,

® Use default location (2eLOCALAPPDATASEATechSmith\SnaglthDataStore)
() Use custom folder:

Make sure to include environment vanables (e.g. %USERNAMER) to create a
unigue location for each user,

Allow users to change the automatically stored files location
Installed outputs

Select the directory to store installed cutputs such as Word, Excel, Google Drive, YouTube,
etc.

® Use default location (3LOCALAPPDATAS TechSmith\Snagit\Outputsh20)

() Use custom folder:

For virtualized environments, you should use a location that is common and
available to all users, For 64-bit environment, we suggest you use:
%COMMONPROGRAMFILES*\TechSmith Shared\Snagit\Cutputsh20

Other user settings

Select the directory to store user settings such as Quick Styles, Cached Thumbnails, TUCI
files, etc.

® Use default location (3LOCALAPPDATASE TechSmith\Snagl)

() Use custom folder:

Make sure to include environment vanables (e.g. %USERNAMER) to create a
unigue location for each user,

You can change or customize the location for storing user data on the User Data Paths screen.

Automatically Stored Files

Snagit automatically saves all capturesinto the DataStore folder. The default location for this folder is:
%LOCALAPPDATA%\TechSmith\Snagit\DataStore.

To help prevent users from losing data and to limit users from changing the path, itis recommended to

disable the option in the Deployment Tool to Allow user to change the automatically stored files location.
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This option for usersis located in Snagit Editor, select Edit > Editor Preferences > Library tab > Library location.

Installed Outputs (Share Destinations)

The Snagit outputs (destinations) appear in the Share dropdown in Snagit Editor and allow users to share their
capturesto popular destinations.

Share 7  Share History £
= (= Eman

@| FTP ’_‘ Program

==

- Clipboard =2 Printer

EI Word - @ PowerPoint -
Excel - Ei OneMote -
n Screencast.com - Camtasia -
m TechSmith Relay  w n YouTube -

‘ Google Drive - Q Dropbox -

&l OneDrive ForBusi. v B34 Box v

,-;'- Slack

The default location to store the installed outputs (destinations) is:
o ForSnagit 2020: %LOCALAPPDATA%\TechSmith\Snagit\Outputs\20

o ForSnagit 2019: %XLOCALAPPDATA%\TechSmith\Snagit\Outputs\19
o ForSnagit 2013: %LOCALAPPDATA%\TechSmith\Snagit\Accessories

If you select a custom folder to store the installed accessories, consider the following items:

« Forroaming profiles, you should use a location that is common and available to all users. Snagit cannot
load outputs (destinations) from a network drive location.

« If auserdoesnot have write access to the folder, Snagit disables the ability for users to update or remove
outputs (destinations) from the Share Preferencesin Snagit Editor.

Other User Settings

User settings such as quick styles, cached thumbnails, additions to the spelling dictionary, TUDI files, etc. are
stored by defaultin: %LOCALAPPDATA%\TechSmith\Snagit.
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Add Components

The components added are included in the Snagit installation.

Al TechSmith Deployment Tool (snagitmsi): Add Components — X

Welcome Add Share Destinations
N

By default, Snagit includes several common share destinations to programs such as
Microsoft Word and PowerPoint. Download additional share destinations from our website
[here]

Impaort Settings

e General Options IE‘

Disable Snagit Settings

WARNING: Some share destinations may have different system requirements than the Snagit
Install Features application.

Add Presets
TechSmith Fuse

Presets are a set of saved capture settings. Add the exported presets files (.snagpresets)
below.

2l

=
E User Data Paths
% Add Components
ql
-

Snagit Reqistry File
Add Tool Themes
Uninstall Options Themes provide a set of branded Quick Styles for each tool in Snagit. Add the exported

theme files {(.snagtheme) below.
TechSmith Relay Options El

Install Display Options

\If'- Create Transform File

Share Destinations

Share destinations are add-ons designed to allow users to upload content to third-party websites and
applications. The destinations appear in the Share dropdown in Snagit Editor.
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Share 7  Share History {3

H File [=7] Email

@| FTP ’_‘ Program

i Clipboard : Printer

EI Word - @ PowerPoint -
Kﬁ Excel - Ei OneMNote -
u Screencast.com - Camtasia -
m TechSmith Relay  + n YouTut -
‘ Google Drive - Q Dropbox -
‘ OneDrive For Busi.. Bion -

.-;'- Slack

The destinations selected on the Install Features screen are included in the installation. To include additional

destinations:

1.

Download more destinations to include with deployment from this website:
https://support.techsmith.com/hc/en-us/articles/115002022732.

On the Add Components screen, click the Add button.
Browse and select the desired .tscplugin file. Control-click to select multiple files.

Click Open.

Presets

Set up a preset to automatically remember your capture settings. Use presets to:

« Save commonly used capture settings.

« Eliminate the setup time before each capture.

« Quickly switch between capture types based on the task at hand.

« Reduce the editing required by automatically adding effects or selecting the share location.
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Edit View Help

@ Preview in Editor
All-in-Cne
Copy to Clipboard
(o]
Image Capture Cursor
L 5 Second Delay
Video

Bordered Image to Word
200x200 Image with Border
Email Watermark

Web Image to Folder

Blog Image

Panoramic Scrolling Capture

Print Screen

& Open Editor

Add Hotkey

Add Hotkey

Add Hotkey

Ctrl+5hift+B

Add Hotkey

To deploy Snagit with additional presets, add the exported Snagit Preset files (.snagpresets) on the Add

Components screen.
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1. Exportthe Snagit Preset file (.snagpresets) in Snagit Editor.

File Edit View Help

. Preview in Editor
All-in-Cne
Copy to Clipboard
[ o]
Image Capture Cursor
o 5 Second Delay Print Screen
Wideo
L Presets +- [ Open Editor
B Eordered Image to Word Add Hotkey E e}

O 200x200 Image with Border L

Add Hotkey &

B Web Image to Folder Add Hot

Edit...
B Blog Image Ctrl+Shit  Rename
3 Panoramic Scrolling Capture Add Hot Duplicate

Delete

2. Onthe Add Componentsscreen, click the Add button.

3. Browse and select the desired .snagpresets file. Control-click to select multiple files.

4. Click Open.
Tool Themes
Themes provide a set of branded Quick Styles for each tool in Snagit Editor.
Quick Styles
Theme: Department Styles -

-“_A;F»
D =
S - B - B
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To deploy Snagit with additional themes, add the exported theme files (.snagtheme) on the Add Components
screen.

1. Export the theme file (.snagtheme) in Snagit Editor.

Quick Styles
Theme: Department Styles -
Basic
Camtasia colors o
Department Styles 7% |
Marketing Styles Edit...
Snagit colors Duplicate

» Urban ExpoiL... I}

New Theme... Delate

Import... 7
8 [

2. Onthe Add Components screen, click the Add button.
3. Browse and select the desired .snagtheme file. Control-click to select multiple files.

4. Click Open.
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Snagit Registry File Options

“L TechSmith Deployment Tool (snagit.msi): Snagit Registry File - ot

’E Welcome

‘ Import Settings

. General Options
Disable Snagit Settings
Install Features
TechSmith Fuse

Uzer Data Paths

B+ @

by

ke 3§

Add Components
Snagit Registry File
Uninstall Cptions
TechSmith Relay Options
Install Display Options

\Tf Create Transform File

Snagit Registry File

You may include a customized Snagit registry file with the deployment. The most common reasons
for doing so are to distribute Snagit with profiles specific to your environment and epting out of
our TUDI (ancnymous usage data collection). While other options and preferences are contained in
the REG file, Quick Styles and Stamps cannot be customized and deployed with Snagit.

The easiest way to obtain the customized registry file is to set up Snagit the way you want on
your computer. Then, exit Snagit completely and select the third option below.

® Do not customize Snagit registry settings
) Customize Snagit registry settings by importing a Snagitreg file:

File name:

Customize Snagit registry settings by using this computer's settings

Snagit is running. Exit Snagit to select this option.

The registry file contains custom settings within the Snagit application such as presets, appearance settings,

and hotkeys.

Some of these custom settings are located in the following locations:

« Inthe Capture Window, select File > Capture Preferences.

« In Snagit Editor, select Edit > Editor Preferences.
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Stamps, Quick Styles, and optionsin the toolbar are not stored in the registry file and cannot be
deployed to multiple users.

To deploy custom Snagit settings to multiple users:
1. Install Snagit.
2. Setup Snagit with the desired settings and customizations for your organization.
3. Close Snagit.
4. Run Command Prompt asan administrator.
5

. Make sure Snagitis not running. To create the Snagit registry file on your desktop, enter the following
into the Command Prompt:
"C:\Program Files\TechSmith\Snagit 2020\Snagit32.exe" /e %userprofile’%\Desktop\Snagit.reg

6. Inthe TechSmith Deployment tool, click the Snagit Registry File tab and select Customize Snagit registry
settings by importing a Snagit.reg file.
7. Click the Browse button to select a Snagit.reg file produced in step 5.
The transform (MST) file generated from the Deployment Tool will use the settings from the registry as the
default settings when installing Snagit.
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Uninstall Options

“& TechSmith Deployment Tool (snagit.msi): Uninstall Options — x
N o Uninstall Options
elcome
A :
Keep or Delete Files
When uninstalling Snagit, users are prompted with the following dialog:
' ‘ Import Settings

XN TechSmith

T -
General Opticns
g
@ Keep Files
[ plan to remstall or have upgraded Snagil.
Disable Snagit Settings Keep my unsaved caplures, flags, keywords,

and caplure information,

Delete Files

Remove unsaved caplunes. Remove keywonds,
flags. and information assocated with saved
caplures.

This affects all installations of Snagit

Install Features

TechSmith Fuse

S
=
i.'
E User Data Paths
%
o

When deploying an uninstall, users will be prompted with the above dialeg, unless you

Add Components choose to keep or delete the user's files below,

®) Prompt users with this dialog
Snagit Registry File '~:«' Keep files
i) Delete files

Uninstall Cptions Previous Versions

To ensure users are running the correct version of Snagit, you can choose to automatically

) ) uninstall previous versions on their machine,
TechSmith Relay Options . )
® Do not uninstall previous versions
) Uninstall all previous versions
Install Display Opticns —
) Uninstall cnly:

d By e

Enter the 2 digit version number (e.g. 18" not “2018"). Separate
\t’ Create Transform File version numbers by a comma. More Information

Keep or Delete Files

When uninstalling Snagit, there are three options for users’ current Snagit files (unsaved captures, flags, tags,
and capture information). If you plan to reinstall or upgrade Snagit for a user, we recommend selecting the
Keep Files option.

Select one of the following options on the Uninstall Options screen:

« Prompt users with this dialog: When uninstalling Snagit, allow the user to select whether to keep or
delete their current Snagit files.
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« Keep files: Automatically keep the user's files when uninstalling Snagit. Users are not prompted with this
dialog.

o Delete files: Automatically deletes the user’s files when uninstalling Snagit. Users are not prompted with
this dialog.

Uninstall Previous Versions

The UninstallerTool.exe isembedded in the TechSmith Deployment Tool. To download, see Download the

Deployment Tool.

You can uninstall previous versions using:

o Uninstallerin the Deployment Tool

« Uninstaller Tool Command Line

To uninstall previous versions without deploying a new version of Snagit, see this support article.

Uninstall Previous Versions using the Deployment Tool

1. Download the Snagit MSl file and the TechSmith Deployment Tool from
www.techsmith.com/enterprise-resources.html.

2. Double-clickthe TechSmith_Deployment_Tool.exe to launch the program.

N7,

r,-I"

TechSmith_De
yment_Tool

On the Welcome screen, click the Open MSI Package button.

Select the Snagit.msifile. If you have not previously downloaded the MSI file, download the file here.

Click Open.

o v b~ W

On the Uninstall Options screen, select an uninstall option:
« Uninstall all previous versions

« Uninstall only: Uninstalls specific versions of Snagit. Enter the Snagit major version number.
Separate versions by a comma. Make sure to enter the 2 digit version number (e.g. 20 not 2020).

7. Select the other desired options in the Deployment Tool for installing the new version of Snagit.
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8. Onthe Create Transform screen, enter the file path and click Create Transform.

9. Thetoolisextracted to the Batch file location selected. Copy the MSI, MST, BAT and
UninstallerTool.exe files to a folder on the target machine.

You must copy the BAT and UninstallerTool.exe files to the same folder and update the file
pathsin the BAT file to match the folder location.

10. Opena command prompt with elevated Admin privileges.

11. Run the batch file to uninstall previous versions of Snagit and then install the new version.

You cannot right-click the BAT file and select Run as administrator to elevate file privileges.

Uninstall Previous Version using Command Line

The Uninstaller tool can be run independently or as part of the Deployment Tool process. Make sure to run
the command prompt with elevated Admin privileges.

Flags and parameters:

-product <insert product_name>

-keep <insert comma-separated version list>
-remove <insert comma-separated version list>

Examples:

1. Remove all versions of Snagit:

UninstallerTool.exe -product snagit

2. Remove only versions 13 and 2019 of Snagit:

UninstallerTool.exe -product snagit -remove 13, 19

3. Remove all versions of Snagit except 2018 and 2019:

UninstallerTool.exe -product snagit -keep 18, 19
The Uninstaller tool writes progress information to the standard output. Windows installer log files are

created for each version of Snagit that is uninstalled. Windows installer log files can be found in the following
locations:
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« MSlinstaller logs: Located in the same folder as the Uninstaller tool and are in the form of "Uninstall_
<version>_Log.txt"

« EXEinstallerlogs: Located in "%localappdata’%\temp” with a file name in the form of "Snagit_<version>_
Snagitlnstaller_<platform>.log"
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TechSmith Relay Options

e TechSmith Deployment Tool (snagitmsi): TechSmith Relay Options — bt
Welcome TechSmith Relay Options
N\
!.‘ . Server Information
¢ Import Settings

Primary Endpoint is the TechSmith Relay Server URL. Team ID is a GUID which identifies
<. General Options one or more TechSmith Relay servers as a single unit.

[ ] Disable installing the TechSmith Uploader Service

Disable Snagit Settings
Primary Endpoint:

Team ID:

TechSmith Fuse

_ [ ] Ignore Server Certificate Warnings
- User Data Paths Enabling this feature will allow recorders to connect to servers with untrusted security
certificates like self-signed certificates (not recommended).

ﬁ Install Features
=
fE

w Add Components
ﬁ Snagit Reqistry File
iy Uninstall Options
v
B TechSmith Relay Options
g Install Display Options

‘\If" Create Transform File

The Relay Options configures Snagit with a share destination to your specific TechSmith Relay instance. For
this configuration, you need to enter both the primary endpoint (server URL) and Team ID.

Select the Disable installing the TechSmith Uploader Service option to prevent the TechSmith Uploader
Service from installing during deployment. We also recommend deselecting the TechSmith Relay Destination
under the Install Features tab.
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You must also select Disable automatic updates under the Disable Snagit Settings tab to prevent the

Uploader from installing during an update.

The primary endpoint value is the web address of your TechSmith Relay Server ending in rest.ashx. For
example, http://www.organziation.com/relay/rest.ashx.

The method for retreiving your Team ID depends on your implementation of TechSmith Relay.

o If you have TechSmith Relay (Self-Hosted), you can log in to the TechSmith Relay website asan
administrator and find it on the Servers page.

B Ttechsmih seday X =+

=]
“— (D £ organization.com +r = @A O

x

M TechSmith Relay’

System Presentations Profiles Users Client Downiloads. 9
¥ Zysan T cenen User: Relay Administrator {relayadmin) Sign Oul
TechSmith Ralay Servers Team ID: asabdch(-Ocac-4190-b461-2912a 1508241
Status  Sorcor Hama Version  Last Updated 1. "*““&""“‘"’@
whww organization com 507 SAR0016 6:59.05 PM 0 0 103

Transcnption Job Counl Encoding Job Count

@ WA OrganEation, com

Status: Cnbng

Last Updated: 050016 18:5505
Manager Service Pld; 10076

Encoding License:  Large

Activation Status:  Actesled

Presentations ane being accepted and processed on this i@ Completed 2.7

SErver.
Publish Job Count
.

v Pending 16

& Quewed 0

B Processing 0

) Failad 0

& Completed 11,897

« If you have TechSmith Relay (Hosted), you can locate the Team ID on the Download Recorders page.

1. Fromyour TechSmith Relay homepage, click the Create button and then click the Download
Recorders link.

2. Onthe Download Recorder page, right-click the Configure Snagit button and Copy the link
address.

3. Pastethelinkinto a text editor and extract the unique Team ID.

It is not recommended to select the option to ignore server certificate warnings.
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Install Display Options

“i TechSmith Deployment Tool (snagit.msi): Install Display Options - ot

Welcome Install Display Options
N\

When the deployment is in progress and Snagit is installing, there are a number of options that will
_ determine what the end user sees on their screen. If you don't want the user to see anything, select
Impart Settings Quiet display (/quiet). Visit the M3DN website for additional details.

. General Options

Display Options
Disable Snagit Settings P . )
(@) Passive display (/passive)
[ ) Quiet display (fquiet
i| Install Features play {fquiet)
F TechSmith Fuse
E‘ User Data Paths
2 Restart Options

e
=

® Do not configure the restart options
Add Components . B
() Prompt before restarting (/promptrestart)

() Mever restart [fnorestart)

S Ll J0 i i Always restart (/forcerestart)

Uninstall Cptions

TechSmith Relay Options

d B e P F

Install Display Options

\Tf Create Transform File

Select one of the following options:

« Quietdisplay: Installs Snagit silently with no setup interface displayed. May be run froma non-
administrator command prompt. It will not return the command prompt until Snagit has finished
installing.

« Passive display: Installs Snagit from an administrator command prompt. It returns the command prompt
immediately (non-blocking). The minimal setup is displayed and Snagit notifies the user when the
installation is complete.
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Create Transform File

Lo TechSmith Deployment Tool (snagit.msi): Create Transform File - ot
}x R END-USER LICENSE AGREEMENT FOR
. TECHSMITH SOFTWARE — SNAGIT® for
Import Settings .
Windows and Mac
General Options IMPORTANT-READ CAREFULLY: This end-user license Agreement
("EULA") is a legally binding license agreement between the entity or
organization you represent, or if you do not designate an entity or an
E Disable Snagit Settings organization in connection with a license purchase, you in your

individual capacity on behalf of yourself ("you” or "your”) and
;él SR TechSmith Corporation, whose address is 2405 Woodlake Drive,

. Okemos, Michigan 48864 ("TechSmith") for the TechSmith Software
identified above and as further defined in this EULA.

‘i-' TechSmith Fuse
BY PAYING THE LICENSE FEE FOR THE SOFTWARE WITHOUT
PROMPTLY REQUESTING A REFUND OF SUCH FEE OR INSTALLING,
f'f User Dats Paths COPYING, OR OTHERWISE USING THE SOFTWARE, SUCH ACTS
INDICATE YOUR ACCEPTANCE OF THIS EULA AND YOUR AGREEMENT
L TO BE BOUND BY THE TERMS AND CONDITIONS OF THIS EULA. IF
fe Add Components YOU DO NOT DESIRE TO ACCEPT THIS EULA OR AGREE TO THE TERMS

OF THIS EULA, PROMPTLY RETURN THE UNUSED SOFTWARE TO THE

ﬁ_ Snagit Registry File PLACE FROM WHICH YOU OBTAINED IT FOR A FULL REFUND OF THE
g LICENSE FEE.
% Uninstall Options [ I have read and accept the End User License Agreement

Transform file: CilUsersha.smith\Desktophsnagitmst T

la TechSmith Relay Options

Install Display Options : -
Batch file: ChUsers\a.smith\Desktopisnagit.bat -

'\Tf' Create Transform File Create Transform...

1. Select|haveread and accept the End User License Agreement checkbox.

2. Click the Create Transform button to generate the following files based on the options selected within
the Deployment Tool:

o Transform file (MST)
» Batch Processing file (BAT)
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Additional Resources

Enterprise Resources

TechSmith Enterprise Resources website
Download other resources and guides to assist with Snagit enterprise installations.

Technical Support

We're here for you! Visit the Technical Support website to submit a ticket, find answers online, or contact an
expert.
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